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Cisco Router and Security Device Manager
Quick Start Guide

Cisco Router and Security Device Manager (SDM) is an easy-to-use device management tool that a
you to configure Cisco IOS security features and network connections through an intuitive web-b
graphical user interface. This quick start guide shows you how to connect your PC to your router
begin using SDM.

SDM runs under Firefox 1.0.3, Internet Explorer version 5.5 or later, and under Netscape 7.1 on 
that is running Microsoft Windows XP, Windows 2000, Windows 2003, Windows ME, or Windows N
4.0 (with Service Pack 4). SDM supports Java plug-in version 1.4.2_05 and later.

If you do not want to use SDM to configure the router, see the“I Use the Cisco IOS Startup Sequence”
section on page 16.

Translated Versions of This Document
Translated versions of this document are available in the following languages: German, Dutch, Fr
Spanish, and Italian.

• Die Deutsche Version dieses Dokuments finden Sie unterhttp://www.cisco.com/go/sdm. Klicken
Sie im linken Rahmen aufTechnical Documentation.

• Voor de Nederlandse versie van dit document ga naar de volgende website:
http://www.cisco.com/go/sdm.

Klik opTechnical Documentationin het linkerdeelvenster.

• Une version française de ce document est disponible à partir du lien suivant:
http://www.cisco.com/go/sdm

Cliquez surTechnical Documentation dans le volet gauche.

• Este documento está disponible en español a través dehttp://www.cisco.com/go/sdm. Haga clic en
Technical Documentation en el margen izquierdo.

• Una versione italiana di questo documento è disponibile ahttp://www.cisco.com/go/sdm. Fare clic
suTechnical Documentation nel riquadro di sinistra.
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Task 1: Install Interface Cards, and Cable the Router
Before SDM can be used to configure the router, you must install all the necessary hardware acces
that are applicable to your router, such as WAN interface cards (WICs), network modules (NMs),
advanced interface module (AIM) cards that you will use to connect to the network. Refer to the q
start guide for your router for instructions on installing these interface cards, cabling the router, a
verifying that all the connections are working properly.

Task 2: Configure Your PC, and Connect It to the Router
You have to set up the PC to communicate with SDM. SDM is shipped with a default configuration
that assigns an IP address to a LAN interface on the router, and you must configure the PC to be o
same subnet as the router LAN interface.

First determine whether your router is configured as a Dynamic Host Configuration Protocol (DH
server or not.

Is Your Router Configured as a DHCP Server?
If you have one of the routers listed inTable 1 on page 3, the router is configured as a DHCP server.
Configure the PC to obtain an IP address and a Domain Name System (DNS) server IP address
automatically, as shown inFigure 1. Connect the Ethernet port on the PC with the router port shown
Table 1.

If you do not find your router model inTable 1, look for the router model you are setting up inTable 2
on page 4 in the section “These Routers Are Not Configured as DHCP Servers.”

Figure 1 Configuring the PC to Obtain an IP Address Automatically
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  Task 2: Configure Your PC, and Connect It to the Router
When you have configured your PC and connected it to the router, go toTask 3: Log on to the Router,
page 6.

Table 1 Routers Configured as DHCP Servers

Router Model Cable Type Connect the Ethernet Cable to the Port Shown

SB101
SB106
SB107
Cisco 831
Cisco 836
Cisco 837

Straight-through
(packed with router)

Connect to any ETHERNET 10BASE T port.

Cisco 850 series
Cisco 870 series

Straight-through
(packed with router)

Connect to any LAN port.

Cisco 1701
Cisco 1710

Crossover, or
straight-through with
Ethernet switch

Connect to 10/100 Ethernet.

Cisco 1711
Cisco 1712

Straight-through
(packed with router)

Connect to any ACT Lnk port.

Cisco 1801
Cisco 1802
Cisco 1803
Cisco 1811
Cisco 1812

Straight-through
(packed with router)

Connect to any SWITCH port.
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12
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12
72
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FDX LINK100WIC 0 OK

WIC
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These Routers Are Not Configured as DHCP Servers
If you did not find your router inTable 1, your router is not configured as a DHCP server, and you mu
assign a static IP address to the PC. ClickUse the following IP address, and assign an IP address
between 10.10.10.2 and 10.10.10.6 to the Ethernet port of the PC, and use the subnet mask
255.255.255.248, as shown inFigure 2. You can leave the Default gateway and DNS server fields blan
Find your router model inTable 2 and connect the Ethernet port on the PC to the router port shown
the table.

Figure 2 Configuring Your PC with a Static IP Address Between 10.10.10.2 and 10.10.10.6

Table 2 lists the routers that are not configured as DHCP servers.

Table 2 Routers Not Configured as DHCP Servers

Router Model Cable Type Connect the Ethernet Cable to the Port Shown

Cisco 1721
Cisco 1751
Cisco 1760

Crossover, or
straight-through
with Ethernet switch

Connect to 10/100 Ethernet.

Cisco 1841 Crossover, or
straight-through
with Ethernet switch

AUX

CONSOLE

LINK

12
72

70

10/100 ETHERNET10/100 ETHERNET

12
72

72

FE 0/0 AUX

FE 0/1 CONSOLE

FDX
100

LINK

FDX
100

LINK
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  Task 2: Configure Your PC, and Connect It to the Router
When you have configured your PC and connected it to the router, go toTask 3: Log on to the Router.

Connect to FE 0/0.

Cisco 2600XM
Cisco 2691

Crossover, or
straight-through
with Ethernet switch

Connect to FE 0. Connect to FastEthernet 0/0.

Cisco 2800 Crossover, or
straight-through
with Ethernet switch

Connect to FE 0/0. Connect to GE 0/0.

Cisco 3600 Crossover, or
straight-through
with Ethernet switch

Connect to FE 0/0. Connect to FE 0/0.

Cisco 3700 Crossover, or
straight-through
with Ethernet switch

Connect to FastEthernet 0/0. Connect to FastEthernet 0/0.

Cisco 3800 Crossover, or
straight-through
with Ethernet switch

Connect to GE 0/0. Connect to GE 0/0.

Table 2 Routers Not Configured as DHCP Servers (continued)

Router Model Cable Type Connect the Ethernet Cable to the Port Shown
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Task 3: Log on to the Router
If you received the SDM CD with your router, use the CD to connect to the router by following the n
procedure. If you did not receive the SDM CD, use the procedure in the“I Did Not Receive the SDM
CD” section on page 7.

I Received the SDM CD
If you received the SDM CD, complete the following procedure.

Step 1 Disable any popup blockers active in your web browser.

Step 2 Place the SDM CD in your PC CD drive. If the CD does not launch, navigate to the drive and
double-click thesetup.exefile.

Step 3 When the CD screen is displayed (Figure 3), click First-time Router Setup.

Figure 3 SDM CD Screen

Step 4 Ensure the PC is connected to the router as described in the First-Time Router Setup window (Figure 4),
and then clickLaunch Cisco SDM Express.
6
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  Task 3: Log on to the Router
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Figure 4 First-Time Router Setup Window

Step 5 Enter the usernamecisco, and the passwordcisco in the login windows that appear during the startup
process. If the login window does not appear, clickWhy did Cisco SDM Express fail?and follow the
recommendations.

Step 6 Go to the“Task 4: Complete Cisco SDM Express” section on page 8.

I Did Not Receive the SDM CD
If you did not receive the SDM CD, use this procedure to connect to the router.

Step 1 Open a web browser on the PC, disable any active popup blockers, and enter the following URL

http://10.10.10.1

Step 2 Enter the usernamecisco, and the passwordcisco in the login window. If other login windows appear
during the startup process, enter the same credentials (cisco/cisco). See the Tip section if the lo
window does not appear.

Step 3 Go to the“Task 4: Complete Cisco SDM Express” section on page 8.
7
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Tip If the launch page does not appear when you enter the URL http://10.10.10.1, test the connection
between the PC and the router by doing the following:

• Check that the Power LED on the router is on, and that the LED for the port to which you conne
the PC is on, indicating an active Ethernet connection between the router and the PC. If this LE
not lit, verify that you are using a crossover cable to connect the PC to the router, or that you
using a straight-through cable between the router and the switch.

• Verify that the web browser “work offline” option is disabled. In Internet Explorer, click theFile
menu, and verify that the “work offline” option is unchecked. In Netscape, the default selectio
the File menu is set to “work online.”

• Verify that the es.tar, home.tar, home.shtml, and common.tar files are loaded into flash memo
Open a Telnet session to 10.10.10.1, entering the usernameciscoand the passwordcisco. Enter the
show flashcommand to verify that these files are loaded in flash memory.

• Verify that the PC IP address is properly configured. Some routers require that the PC obtain
address automatically and some require that it be configured with a static IP address. Find y
router in eitherTable 1 on page 3 or Table 2 on page 4 to determine how the PC should be
configured.

Task 4: Complete Cisco SDM Express
Cisco SDM Express is an SDM program that lets you quickly configure the router LAN and Intern
connections.

Step 1 When you connect to the router, the SDM Express Launch page (Figure 5) appears, followed by one or
more certificate windows. ClickYes, or click Grant  to accept the certificates.

Figure 5 SDM Express Launch Page
8
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Step 2 The SDM Express Overview page appears and then the SDM Express Wizard page is also displ
(Figure 6). Click Next to begin configuring the router.

Figure 6 SDM Express Overview and Wizard Pages

Tip The SDM Express wizard will ask you to enter an enable secret password to control access to Cisc
software. Be sure to write down or remember the enable secret password that you enter. It is not s
in the Enable Password field or in the Summary window, and it cannot be reset without erasing the r
configuration. You are also asked to change the router’s LAN IP address from its default value.

Step 3 When the Summary window appears, write down the LAN IP address, the username and the use
password that you entered, and clickFinish. You will need this information to reconnect to the router to
perform additional configuration.

Step 4 Exit SDM Express and complete“Task 5: Reconnect to the Router Using the New IP Address” to
reconfigure the PC and reconnect to your router, using the new IP address that you gave to the L
interface.
9
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Task 5: Reconnect to the Router Using the New IP Address
If you changed the IP address of the router LAN interface as recommended in the SDM Express wi
you lost your connection to the router. Follow these steps to reconnect to your router:

Step 1 Reconfigure your PC if necessary. If you configured a DHCP server on the router in Task 4, conf
the PC to obtain an IP address automatically, as shown inFigure 1 on page 2. If the router was already
configured as a DHCP server but the address pool has changed, open a command window on the
enteripconfig /release, followed byipconfig /renew to obtain a new IP address from the router.

If you did not configure a DHCP server on the router, your network uses static IP addresses, and
must assign a new IP address to the PC Ethernet interface. Place it on the same subnet as the r
Ethernet port, which you configured in Task 4.Figure 7 shows an example PC configuration when the
router LAN IP address is 20.20.20.1 (as indicated by the Default gateway field) and the subnet ma
255.255.255.0. The PC is configured with an IP address of 20.20.20.2, an address on the same su
the router.

Figure 7 If you did not configure the router as a DHCP server, configure the PC with a static IP
address (Example)

Step 2 Open a web browser and enter the new IP address that you gave the router LAN interface.

http:// new-IP-address

For example, if you gave the LAN interface the IP address 20.20.20.1, you would enter the follow
command in the browser.

http://20.20.20.1

Step 3 Enter the username and password that you specified in Task 4. If SDM is installed on your route
SDM home page appears, as shown inFigure 8.
10
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Figure 8 SDM Home Page

If you followed the procedure in the“I Received the SDM CD” procedure on page 6, the SDM Express
Overview window appears, as shown inFigure 9 on page 12.
11
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Figure 9 SDM Express Overview Window

Step 4 Test the Internet (WAN) connection that you configured by opening another web browser window
connecting to a website. If you can connect to a website, such as www.cisco.com, your WAN conne
works properly. If you cannot, you can use SDM Express or SDM to correct your WAN settings.

Step 5 If you received the SDM CD, go to“Task 6: Install SDM from the CD” to install SDM.

If you did not receive the SDM CD, SDM is already installed on your router. You can proceed to t
“Using SDM” section on page 14 to learn about SDM.

Task 6: Install SDM from the CD
If you have the SDM CD, you can install SDM on the PC and on the router. If SDM launched when
reconnected to the router inTask 5: Reconnect to the Router Using the New IP Address, SDM is already
installed on the router and you do not need to complete this procedure.

The installation wizard on the CD guides you through installing SDM and its components on you
and your router. Installing SDM on your PC allows you to use SDM to configure and manage oth
routers on your network.

Step 1 Return to the CD screen, and clickInstall SDM  (Figure 10 on page 13).
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Figure 10 Click Install SDM

Step 2 When the Install Options window appears (Figure 11), select where you want to install SDM. Selecting
This Computer installs SDM on the PC and enables you to configure and monitor other routers on
network besides the router you have just set up.

Figure 11 Select Where You Want to Install SDM

You can also install SDM and its other applications on your router, or you can install them on bot
PC and the router.

Step 3 Complete the installation wizard.
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Using SDM
If SDM is installed on the router, start it by opening a browser and entering the new IP address th
you gave the LAN interface, just as you did inTask 5: Reconnect to the Router Using the New IP
Address, page 10.

http:// new-IP-address

If SDM is installed on the PC, start it by selecting it from the program menu (Start > Programs >
Cisco Systems > SDM 2.1. Then, provide the IP address of the router in the SDM Launcher windo
(Figure 12).

Figure 12 SDM Launcher

Tip If you are using Internet Explorer on a PC running Windows XP with Service Pack 2, and Interne
Explorer displays a message telling you that it has restricted this file from showing active conten
could access your computer, selectTools > Internet Options > Advanced from the Internet Explorer
Tools menu, and checkAllow active content to run in files on my computer. Then clickApply, and
relaunch SDM.

Cisco SDM provides a series of easy-to-use wizards that quickly take you step by step through
configuring your router, without requiring knowledge of the Cisco IOS software CLI. You can use SD
wizards to:

• Configure additional LAN and WAN connections.

• Create firewalls.

• Configure VPN, Easy VPN, and DMVPN connections, and create and manage digital certifica

• Perform a security audit on the router and have SDM fix security problems.

• Configure basic routing.

• Create Network Address Translation (NAT) rules on the router.

• Create Quality of Service (QoS) policies.

After you have used wizards to create basic configurations, SDM enables you to edit the configura
you created. You can edit firewalls to create a firewall policy for your network. You can also confi
and manage the Intrusion Prevention System (IPS) on the router to protect your network from at
and perform additional tasks, such as creating user accounts and creating router management p

To start a wizard, simply click the Configure button at the top of the SDM home page shown inFigure 8
on page 11, and then click the appropriate button in the left frame of the SDM Configuration windo
Figure 13 on page 15.
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Figure 13 An SDM Configuration Window

Click theHelp button in any SDM window for more information on the task you are performing.

SDM automatically saves changes to the router’s running configuration, and you can direct it to sav
running configuration to the startup configuration.

You’re Done! Where to Go from Here
Now that you have used SDM to give your router an initial configuration, you can continue to use S
to configure additional features or modify existing feature configurations.You can use the SDM UR
start SDM and then add to or modify your router configuration at any time.

If you have other supported routers on which you would like to install SDM, see the“Obtaining the
Latest Version of SDM” section on page 16.

For More Information About SDM and About Your Router
For additional information about SDM features, refer to the SDM online help. Additional informat
about SDM is also available on the SDM website athttp://www.cisco.com/go/sdm. This website
provides access to detailed information about SDM, including an SDM FAQ, data sheet, custome
presentation, Flash demo, and links to technical documentation and product updates. If you are
configuring a Cisco 83x router, you should obtain the documentSwitching From Cisco Router Web Setup
to Cisco Router and Security Device Manager on Cisco 83x Series Routers.
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Refer to the quick start guide for your router for other procedures, such as connecting a PC to the r
console port so that you can use the CLI when you need to, and using the router LEDs to verify
installation. The quick start guide may also contain important warranty information.

Obtaining the Latest Version of SDM
SDM is regularly enhanced to provide new features. If you are already running SDM on the router,
can update SDM automatically by clicking on the Tools menu and selectingUpdate SDM. SDM will
determine if there is a more recent version available and enable you to download it and install it o
router.

If you have a supported router that does not have SDM installed, you can download the latest vers
SDM free of charge and instructions for installing it on your router from the following location:

http://www.cisco.com/pcgi-bin/tablebuild.pl/sdm

You should consult the SDM release notes to determine if it is supported for the router on which 
want to install it.

Updating SDM from the CD
You can use the SDM CD to update the SDM software on other routers. Follow the procedure in 
“Task 6: Install SDM from the CD” section on page 12, selectingCisco Router in the Install Options
screen inFigure 11 on page 13. Provide the router’s IP address, a username with privilege level 15 a
the password. When asked if you want to overwrite the SDM software, clickYes. The Installation wizard
will update SDM software on your router.

I Use the Cisco IOS Startup Sequence
This section explains how to use the Cisco IOS startup sequence to configure your router instead of
SDM.

Note If you have already configured the router using SDM, you do not need to read this section.

Because SDM uses a default configuration file, your routerwill not execute the standard Cisco IOS
startup sequence. You can use this section to run the Cisco IOS setup utility and take advantage o
TFTP or BOOTP configuration download, or use other features available through the standard Cisc
startup sequence. It also tells you what to do if you want to use SDM in the future.

The configuration file shipped with your router does the following:

• Provides an IP address for your Fast Ethernet interface, enabling an interface to your LAN

• Enables your router’s HTTP/HTTPS server, allowing HTTP access from your LAN

• Creates a default username (cisco) and password (cisco) with privilege level 15

• Enables Telnet/SSH access to the router from your LAN

If you want to erase the existing configuration and take advantage of the Cisco IOS startup sequ
perform the following steps. SDM will remain on the router.
16
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Step 1 Connect the light blue console cable, included with your router, from the blue console port on your ro
to a serial port on your PC. Refer to your router’s hardware installation guide for instructions.

Step 2 Connect the power supply to your router, plug the power supply into a power outlet, and turn on 
router. Refer to your router’s quick start guide for instructions.

Step 3 Use HyperTerminal or a similar terminal emulation program on your PC, with the terminal emula
settings of 9600 baud, 8 data bits, no parity, 1 stop bit, and no flow control, to connect to your ro

Step 4 At the prompt, enter theenablecommand. The default configuration file does not configure an enab
password.

yourname> enable

yourname#

Step 5 Enter theerase startup-configcommand.

yourname# erase startup-config

Step 6 Confirm the command by pressingEnter.

Step 7 Enter thereload command.

yourname# reload

Step 8 Confirm the command by pressingEnter.

After you press Enter, the router will begin executing the standard startup sequence. If you want t
SDM to perform subsequent configurations for the router, you must manually configure the route
support web-based applications, and the Telnet and Secure Shell (SSH) protocols. You must also
a user account with a privilege level of 15. See the“I Want to Enable SDM on a Router I Configured
Using the Cisco IOS Startup Sequence” section for this information.

I Want to Enable SDM on a Router I Configured Using the Cisco IOS Startup
Sequence

This section provides information on enabling SDM on a router that has been configured using the C
IOS startup sequence or the CLI. If you erased the factory startup configuration in order to use the
IOS startup sequence, you can still use SDM. In order to do so, you must configure the router to su
web-based applications, configure it with a user account defined with privilege level 15, and then
configure it to support the Telnet and SSH protocols. These changes can be made using a telnet s
or using a console connection.

Configuring the Router to Support Web-Based Applications, a User with Priv 15, and Telnet/SSH

Step 1 Enable the router’s HTTP/HTTPS server, using the following Cisco IOS commands:

Router(config)# ip http server
Router(config)# ip http secure-server
Router(config)# ip http authentication local

If the router uses an IPSec Cisco IOS image, the HTTPS server is enabled. Otherwise only the H
server is enabled.
17
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Step 2 Create a user account with privilege level 15 (enable privileges).

Router(config)# username  < username > privilege 15 password 0  < password >

Replace<username> and<password> with the username and password that you want to configure

Step 3 Configure SSH and Telnet for local login and privilege level 15:

Router(config)# line vty 0 4
Router(config-line)# privilege level 15
Router(config-line)# login local
Router(config-line)# transport input telnet
Router(config-line)# transport input telnet ssh
Router(config-line)# exit

Step 4 (Optional) Enable local logging to support the log monitoring function:

Router(config)# logging buffered 51200 warning

To begin using SDM on a router that has received a manual configuration, read the next section.

Starting SDM on a Manually Configured Router

SDM is a web-based application that must be run from a PC that is connected to the router over a
SeeTable 1 on page 3 or Table 2 on page 4 to determine which router port to connect the PC to. If th
router is configured as a DHCP server, the PC must be configured to receive an IP address automa
If the router is not configured as a DHCP server, you must configure the PC with a static IP addre
the same subnet as the router interface to which you are connecting the PC. For example, if the 
interface has the IP address 172.16.30.1, and the subnet mask is 255.255.255.248, you must co
the PC IP address in the range 172.16.30.2 through 172.16.30.6.

Step 1 Open a web browser on the PC, and enter the IP address that you gave the router LAN interface

https:// LAN-IP-address

Step 2 Enter the username and password that you specified inStep 2 of “Configuring the Router to Support
Web-Based Applications, a User with Priv 15, and Telnet/SSH.”

The SDM Overview window appears, as shown inFigure 8 on page 11. To continue configuring your
router, see the“Using SDM” section on page 14.

Cisco.com
You can access the most current Cisco documentation on the World Wide Web at this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

See the quick start guide for the router you have just configured for information on obtaining othe
documentation, providing documentation feedback, and obtaining technical assistance.
18
Cisco Router and Security Device Manager Quick Start Guide

78-16254-06

http://www.cisco.com/univercd/home/home.htm
http://www.cisco.com


  Cisco.com
Printed in the USA on recycled paper containing 10% postconsumer waste.

Copyright © 2005 Cisco Systems, Inc. All rights reserved.

CCSP, CCVP, the Cisco Square Bridge logo, Follow Me Browsing, and StackWise are trademarks of Cisco Systems, Inc.; Changing the Way We Work, 
Live, Play, and Learn, and iQuick Study are service marks of Cisco Systems, Inc.; and Access Registrar, Aironet, BPX, Catalyst, CCDA, CCDP, 
CCIE, CCIP, CCNA, CCNP, Cisco, the Cisco Certified Internetwork Expert logo, Cisco IOS, Cisco Press, Cisco Systems, Cisco Systems Capital, 
the Cisco Systems logo, Cisco Unity, Enterprise/Solver, EtherChannel, EtherFast, EtherSwitch, Fast Step, FormShare, GigaDrive, GigaStack, HomeLink, 
Internet Quotient, IOS, IP/TV, iQ Expertise, the iQ logo, iQ Net Readiness Scorecard, LightStream, Linksys, MeetingPlace, MGX, the Networkers logo, 
Networking Academy, Network Registrar, Packet, PIX, Post-Routing, Pre-Routing, ProConnect, RateMUX, ScriptShare, SlideCast, SMARTnet, 
The Fastest Way to Increase Your Internet Quotient, and TransPath are registered trademarks of Cisco Systems, Inc. and/or its affiliates in the 
United States and certain other countries. 

All other trademarks mentioned in this document or Website are the property of their respective owners. The use of the word partner does not imply a 
partnership relationship between Cisco and any other company. (0601R)
19
Cisco Router and Security Device Manager Quick Start Guide

78-16254-06



  Cisco.com
20
Cisco Router and Security Device Manager Quick Start Guide

78-16254-06


	Cisco Router and Security Device Manager Quick Start Guide
	Translated Versions of This Document
	Task 1: Install Interface Cards, and Cable the Router
	Task 2: Configure Your PC, and Connect It to the Router
	Is Your Router Configured as a DHCP Server?
	These Routers Are Not Configured as DHCP Servers

	Task 3: Log on to the Router
	I Received the SDM CD
	I Did Not Receive the SDM CD

	Task 4: Complete Cisco SDM Express
	Task 5: Reconnect to the Router Using the New IP Address
	Task 6: Install SDM from the CD
	Using SDM
	You’re Done! Where to Go from Here
	For More Information About SDM and About Your Router
	Obtaining the Latest Version of SDM
	Updating SDM from the CD

	I Use the Cisco IOS Startup Sequence
	I Want to Enable SDM on a Router I Configured Using the Cisco IOS Startup Sequence
	Configuring the Router to Support Web-Based Applications, a User with Priv 15, and Telnet/SSH
	Starting SDM on a Manually Configured Router


	Cisco.com


